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Accessing Microsoft Word

To access Microsoft Word from your home computer, you will probably either use the
Start menu to select the program or double-click on an icon on the Desktop.

To open Microsoft Word 2002

from the computers in the 9
computer lab at the library,

simply click once on this button.

Anatomy of a Word Window

When you open up Microsoft Word 2002, the top of the window should look like this:

Title Bar
Menu Bar
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Depending upon how you customize Microsoft Word and what version of Microsoft
Word you are using, other icons, toolbars, and menus may also be present.

Title Bar

The Title Bar will tell you what document you are currently viewing. If you have just
opened a new document and have not yet named it, Word will name it for you.

Menu Bar

The Menu Bar lists the menus available to you when using Word. These menus contain
lists of commands and options you can use with Word. To open a menu, click once on
the menu’s name (File, Edit, View, etc.), then click on the option you want.



Toolbars

The toolbars provide shortcuts to frequently used commands. The most commonly
used Microsoft Word commands are located on the Standard Toolbar and the
Formatting Toolbar. Other toolbars can be added to the window by selecting
“Toolbars” in the View menu and clicking on the name of the toolbar you want to add.

Here is what some of the icons on these toolbars do:
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New Blank Document — Creates a new, blank document using the default
template

W

Open — Allows you to find and open an existing document on the hard
drive, a floppy disk, or a CD

A

Save — Saves the document you are currently viewing to its current
location (if a location has already been specified)

Print — Sends the document you are currently viewing to the printer to
make a paper copy
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Print Preview — Shows you exactly how a document will look when you
print it
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Spelling and Grammar — Checks the document you are currently viewing
for mistakes in spelling and grammar and provides suggestions for
correcting errors

S

Cut — Removes selected text or objects from the document and copies it
to the Clipboard for future use

Copy — Copies selected text or objects to the Clipboard for future use

Paste — Inserts selected text or objects that have been cut or copied to
the Clipboard wherever the cursor has been placed

Bold — Makes selected text bold
Italic — Makes selected text italic

Underline — Underlines selected text
Align Left — Aligns text to the left-hand side of the document
Center — Centers text in the middle of the document
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Align Right — Aligns text to the right-hand side of the document

Ruler

The ruler allows you to customize the layout of your document by setting tabs, which
determine the length of paragraph indentations and other types of spacing.



Creating a New Document

When you first open Microsoft Word, a new, blank document will automatically be
created. If you need to create another new, blank document, follow these steps:

1. Click once on the
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2. In the File menu,
select the first option,
which is "New..."”

3. In the menu
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' window, click on

"Blank Document”
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Editing a Document

Typing
When using Microsoft Word, text is entered by typing with the keyboard.

e The text typed will appear in the document wherever
the cursor, a blinking, vertical line, is located.

e The cursor can be moved either by using the mouse
to click on a new location or by using the arrow keys
on the keyboard.

e Asyou are typing and reach the end of a line, the
computer will automatically move the cursor to the
next line. This is called “word wrap.”

e Hitting the Enter key on the keyboard will move the
cursor down one line to end a paragraph or to create
a blank line.

Selecting Text

To change the style and size of text or to copy or move text that has already been
typed into the document, the text must first be selected. Selecting text is also called
“highlighting.” This is what selected text looks like on the screen: JJ[SIg{=Ie R{=Nq

You can select text by clicking directly in front of or at the end of the text you want to
select, then dragging the mouse pointer over all of the text you wish to select while
holding down the left mouse button. In addition, there are several shortcut techniques
you can use to select text:

1. One entire word — Double-click anywhere on the word

2. One entire sentence — Hold down the “Ctrl” key on the keyboard and click
anywhere within the sentence

3. One entire paragraph — Triple-click anywhere within the paragraph

4. All text in a document — Click on “Edit” in the Menu Bar to open the Edit menu,
then choose “Select All”

To deselect text, click anywhere on the document outside of the selected text.

Erasing Text

There are several methods you can use to erase text and remove it from a document.

e Place the cursor at the end of the text you want to erase and press the
Backspace key on the keyboard once for each character you wish to erase.

e Place the cursor at the beginning of the text you want to erase and press the
Delete key on the keyboard once for each character you wish to erase.

e Select all of the text you want to delete and press the Delete key.



Cut, Copy and Paste

In order to move text from one part of a document to another without deleting or
retyping, you can use the Cut and Paste commands.

1. Select the text you want to move.

2. Click on the Cut icon ( & ) on the Standard Toolbar.

3. Use the mouse to insert the cursor at the new location where you want the cut
text to be placed.

4. Click on the Paste icon ( & ) on the Standard Toolbar.

In order to copy text so that you do not have to retype it if you want it to be repeated
in your document, you can use the Copy and Paste commands.

1. Select the text you want to copy.

2. Click on the Copy icon (52 ) on the Standard Toolbar.

3. Use the mouse to insert the cursor at the new location where you want the
copied text to be placed.

4. Click on the Paste icon ( B2 ) on the Standard Toolbar.

Formatting Text

You can use the drop down menus and icons on the Formatting Toolbar to change the
font (also called the “typeface”), the size and style of text, and where text is placed on
the page. You can make changes to the appearance of all text in a document or of just
some text in a document. In order to do this, you must first select the text you want to
change. Then, click on the appropriate drop down menu or icon on the toolbar.

Align text to the left.

Make text italic. Center text,
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TIP: More options for formatting text are available by clicking on “Font...” in the Format
menu.



Saving Documents

Once you have created a document, you can save a copy of it to the computer’s hard
drive or to a floppy disk. To save a document, follow these steps:

1. Click once on the
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5. Click on the "Save" button.
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on the "Save" icon.
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TIP: If you have already
saved a document once
and wish to save it again
in a different location or
under another name,
choose “Save As...”
instead of “Save” in the
File menu.
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Opening a Saved Document

If you have saved a document and want to work on it again or print it, follow these

steps to open the document for editing:
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Printing Documents

In order to make a paper copy of your document, you will have to print it. The printer
for all of the computers in the library’s computer lab is located outside of the lab at the

Reference Desk.

Print Preview

To see exactly how your document will look when printed, choose Print Preview before
actually printing the document. Follow these steps to do this:

1. Click once on the

WOI‘d "File" on the % File Edit  Wew Insert  Format
bexEdan gLV

Menu Bar to open i —— Fie
the File menu. ——— T D new.. — coln
= Cpen... ChHO
Close
Save Chrl+5
Save As...
gy Save as Web Page...
By Search...
— 2_. In the
‘'eb Page Preview Flle menuf
E—— select "Print
Or IR ||E, Print Prexview ( PI‘EViEW"
&5 Frint... Chrl+P
Send To 3
USE the ShOI‘tCI.It on File Edit ‘iew Insert Format Exit

the toolbar by NEEan

clicking once on the 21 Normal
"Print Preview" icon. . eE—

~ Times Mew

Once you have finished looking at the Print Preview, you can close Print Preview and
return to your document by clicking on the “Close” button on the toolbar.
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Printing a Document

To print a document, follow these steps:
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Printing Options

When printing a document, you can choose what pages or specific text you would like
to print and how many copies you need. NOTE: If you use the shortcut for Print in the
toolbar, you will NOT get the printing options.

Printer
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Click here to print once you choose the options you want



Glossary of Terms

Alignment

AutoCorrect

Bold

Border

Bullet
Character

Clipboard

Copy

Cursor

Cut

Default

Edit

File Name

The position of text on the page. Text can be aligned to the right-
hand side of the page or the left-hand side of the page or both
(justified), as well as centered in the middle of the page.

A function of Microsoft Word that automatically corrects common
spelling mistakes as you type. This function can be turned on and
off as needed.

A style of text that appears darker and thicker than normal text.

A line or design that goes around the edge of the page, certain text
on the page, or tables or images.

A distinguishing character placed in front of items in a list.
A single letter, number, or symbol.

A place where text and objects are temporarily placed after being
cut or copied so that they can then be pasted where desired.

A command that allows you to make an exact copy of selected text
to be placed at another location within the same document or at
any location within another document.

The place at which you are in a document and at which text will
appear when typed, usually represented by a blinking, vertical line.
Also called the “insertion point.”

A command that allows you to remove selected text from a
document so that you can place it at a different location within the
same document or at any location within another document.

A predefined setting that is built into a program and will be present
each time that program is run unless an alternative setting is
specified.

To add, delete, or change information (text, images, tables, etc.)
within a document.

The name assigned to a document either automatically by the
computer or by the user when saved.
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Font

Footer

Format
Header

Indent

Italic

Landscape

Margin

Orientation

Overtype
Mode

Page Break

Paste

Point Size

Portrait

Rename

The visual design of characters. Also called a “typeface.”

Text printed at the bottom of one or more pages of a document,
often used for numbering pages.

The way text appears on a page.

Text printed at the top of one or more pages of a document.

The distance text is moved into the body of a document from the
document’s margin, usually referring to the first line of a
paragraph.

A style of text that is slanted to the right.

A page setting that allows for text to be printed sideways across
the widest part of the page.

A boundary that controls how close text can come to the edge of a
page.

Tells which way text will be printed on a page, such as landscape
or portrait.

A setting that allows you to replace an existing character with a
different character without shifting text or using the Backspace or
Delete keys. Can be turned on and off by pressing the Insert key
on the keyboard.

Determines the end of one page and the beginning of the next
page. Can be automatically created by the program based on the
margins or manually inserted by the user.

A command that allows you to insert cut or copied text into a
document.

The height of a character. 72 points = 1 inch.

A page setting that allows for text to be printed across the narrow
part of a page.

To change the name of a saved document.
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Shortcut Key combinations you can use in place of using the mouse and

Keys menus to give the computer commands.

Shortcut Menus that appear when an object or text is right-clicked with the
Menus mouse and allow you to perform common functions more quickly.

Template A special kind of document that provides a basic format and set of

guidelines for a certain type of document.

Thesaurus A tool that allows you to look up synonyms and antonyms for
words in a document.

Toggle To give the computer the same command once to turn a feature
on, then again to turn that feature off.

Wizard A tool that guides you through a task in a series of easy-to-follow
steps.
Word Wrap A feature of Microsoft Word that automatically moves you to the

next line when you reach the end of the line you are on.

Further Reading Suggestions

These books, available from the library, will help you learn more about the various
versions of Microsoft Word and how to use them. The version of Word used at the
library, Microsoft Word 2002, may be different than the version you use on other
computers at home, work, or school.

Microsoft Word 97
Teach Yourself Microsoft Word 97 in 24 Hours by Linda Jones & Ruel Hernandez

Microsoft Word 2000

Exploring Microsoft Word 2000 by Robert Grauer
How to Use Microsoft Word 2000 Visually in Full Color by Sherry Kinkoph

Microsoft Word 2002

Word 2002 for Dummies by Dan Gookin
Microsoft Word 2002 10 Minute Guide by Joe Habraken (NetLibrary e-book)

Microsoft Word 2003
Microsoft Word 2003: Top 100 Simplified Tips & Tricks by Jinjer Simon
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